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1 Welcome to the Clay Tablet Connector for Sitecore

1.1 The Translation Lifecycle

1 Welcome to the Clay Tablet Connector for Sitecore
Welcome to the Clay Tablet Connector for Sitecore, Special Edition for use with Lionbridge onDemand
("Connector"). The Connector enables you to automate sending and retrieving content from Sitecore directly to
and from onDemand. This dramatically reduces the effort required to create, maintain, and publish Web
content in multiple languages.

1.1 The Translation Lifecycle
The translation lifecycle is the broad process of selecting content, sending it out for translation, and then
receiving the translated content back from translation.
This set of steps usually fits inside a larger, more general process called the content lifecycle, which is the
process of creating, reviewing, editing, approving, and publishing content.
When you consider the translation lifecycle and the content lifecycle together, you have the global content
value chain, which is the strategy for managing multilingual content.
The content lifecycle and the translation lifecycle are impacted by the workflow steps you implement in Sitecore
to manage multilingual content.
Remember that localizing content is a subset of steps in the broader content lifecycle. This will improve your
focus on key localization considerations, improve processes, and keep all content stakeholders included.
Together, this results in better content management.

1.2 How the Connector Helps You Manage Your Translation Lifecycle
The Clay Tablet Connector for Sitecore ("Connector") is a plug-in module for Sitecore. It provides a range of
features and user interface enhancements in Sitecore that enable you to select, send, monitor, and retrieve
content for translation into any language Sitecore supports.
These features automate the process, which dramatically reduces the effort and time required to export and reimport content that needs to be localized. This is very helpful when translating large volumes of content or
ensuring that translated content is quickly re-imported to meet deadlines.
When you use the Connector, you manage your translation lifecycle entirely from within Sitecore:
1. The Connector exports your content from Sitecore in either XML or HTML format and delivers these content
files to the central, hosted Clay Tablet Platform.
2. The Clay Tablet Platform delivers your content to onDemand, based on routing rules that your company
chooses and Clay Tablet Technologies implements.
3. When the translated content is ready, the Clay Tablet Platform retrieves it from onDemand and delivers it to
the Connector.
4. The Connector automatically re-imports the content into the correct location in Sitecore.
You can then review, revise, reject, or publish the translated content as needed.
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1 Welcome to the Clay Tablet Connector for Sitecore

1.3 Using this Guide

Note: Neither the Connector nor the Clay Tablet Platform performs any translation. Similarly, Clay Tablet
Technologies does not provide any translation services. These are provided by Lionbridge.

1.3 Using this Guide
Purpose of this guide
This guide describes how to use the Clay Tablet Connector for Sitecore ("Connector") to manage your
translation lifecycle. It describes how to send Sitecore items for translation and receive them back from
translation.

Who should use this guide
This guide is intended for content editors, project, marketing, localization or translation managers, or others
who are responsible for creating, editing, or approving content for translation that resides in your Sitecore CMS.
This guide is also useful for translation providers who receive content from your Sitecore CMS, because it
describes your company's translation management process.

What your company setup should be
This document assumes that:
Your company already has a functioning instance of Sitecore.
The Clay Tablet Connector for Sitecore ("Connector") has been implemented, configured, and tested on your
Sitecore CMS.
Clay Tablet Technologies has set up the Clay Tablet Platform to send content to your translation providers.
Lionbridge is your company's translation provider, and onDemand is already set up for your company.

What you should already know
This document assumes that:
You are familiar with the Connector's configuration for your Sitecore CMS, and the reasons for choosing
certain configuration options. This is important because your company's configuration determines which
features are available.
You have a strong working knowledge of the Sitecore Content Editor.
You are familiar with the basic concepts of the Sitecore Workflow features. This is crucial, because workflow is
a core concept required to use the Connector.
You are familiar with your company's translation process and requirements.
You have valid user credentials to log into Sitecore.
You have the required permissions to access the Connector functionality described in this guide.
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1 Welcome to the Clay Tablet Connector for Sitecore

1.3 Using this Guide

Note: Not all the features described in this guide may be available. Feature availability depends on both your
company's Connector setup and the roles to which you are assigned. If you cannot access functionality that
you need, contact your company's Sitecore administrator.

How this guide is organized
This guide contains the following chapters:
Chapter

Description

"Welcome to the Clay
Tablet Connector for
Sitecore" on page 5

A brief description of the Clay Tablet for Sitecore solution and how it fits into the
translation lifecycle. It also includes information about this guide and Clay
Tablet Technologies Support contact information.

"Getting Started with the
Clay Tablet Connector for
Sitecore" on page 9

How to get started and an overview of the Clay Tablet Connector for Sitecore
interface and key features.

"Creating Content for
Translation" on page 20

How to create, adapt, and filter Sitecore content so that you can send it out for
translation using the Clay Tablet Connector for Sitecore.

"Sending Content to
Translation" on page 38

How to use the Clay Tablet Connector for Sitecore to send out content for
translation.

"Monitoring Translation
Status" on page 82

How to monitor the translation status of content that you sent out for
translation.

"Reviewing Translated
Content" on page 107

How to review and publish translated content after it automatically returns
from the translation provider to the Sitecore CMS.

"Post-Translation
Features" on page 110

How to perform post-translation tasks, including synchronizing translations,
requesting a translation correction, updating a remote TM (translation
memory) server, and clearing the translation backup data.

How to find out more about Clay Tablet Connector for Sitecore
For information on installing and configuring the Clay Tablet Connector for Sitecore, read the Clay Tablet
Connector for Sitecore Installation and Configuration Guide, Special Edition for use with Lionbridge
onDemand.

Documentation conventions
This guide uses the following conventions:
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1 Welcome to the Clay Tablet Connector for Sitecore

1.4 How to Contact Clay Tablet Support

Convention

Description

Bold

Highlights screen elements such as buttons, menu items, and fields.

Courier

Highlights input, file names, and paths.

Italics

Highlights terms to emphasize, variables, or document titles.

>

Indicates a menu choice. For example, "Select Sitecore Desktop > All Applications > CTC
Translation > Translation Filter."

1.4 How to Contact Clay Tablet Support
Email @: support@clay-tablet.com
Telephone: +1-416-363-0888 option "3"
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2 Getting Started with the Clay Tablet Connector for Sitecore

2.1 Key Features

2 Getting Started with the Clay Tablet Connector for Sitecore
The Connector supports the Mozilla Firefox and Google Chrome web browsers. The Connector supports
Microsoft Internet Explorer 11 with Sitecore 7 and 8.
To access the Connector, log into Sitecore.

2.1 Key Features
The Clay Tablet Connector for Sitecore (the "Connector") has the following key features:
"Multiple Ways of Sending Content for Translation" on page 9
"Optimizing Translation Costs" on page 9
"Selecting a Translation Provider" on page 10

2.1.1 Multiple Ways of Sending Content for Translation
There are the following multiple ways to send content items out for translation:
Send a single content item for translation from the Sitecore Content Editor. For details, see "Submitting a
Content Item for Translation using the Content Editor" on page 39.
Send a single content item for translation from the Sitecore Page Editor (Sitecore 6 and 7) or the Sitecore
Experience Editor (Sitecore 8). For details, see "Submitting Content for Translation from the Page Editor
or the Experience Editor" on page 46.
Send multiple content items using the Bulk Translation wizard. You can filter to exclude content, and
send out requests for translations of one target language at a time. For details, see "Sending Multiple
Content Items for Translation" on page 51.
Depending on your company's Connector configuration, you may be able to send content out for translation
either immediately or via a queue.
Send content immediately to the translation provider.
Send content via the Translation Queue, which enables you to group items together by project and
priority, target language, and require additional approval. For details, see "Submitting Content for
Translation from the Translation Queue" on page 73.

2.1.2 Optimizing Translation Costs
The Optimize Translation feature helps you reduce translation costs, by reducing the quantity of content that
Connector sends to translation providers. It sends only changed content fields out for translation. To do this, it
checks each field of the source version for any content changes.
However, this feature needs Connector translation backup data, and it increases the Connector processing time
before sending out the items for translation. For information on enabling Connector translation backup data,
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2 Getting Started with the Clay Tablet Connector for Sitecore

2.2 The Connector at a Glance

refer to the Clay Tablet Connector for Sitecore Installation and Configuration Guide, Special Edition for use with
Lionbridge onDemand.
This feature is available:
by selecting the Sync Translation check box in the Translation Options page of the Bulk Translation wizard,
as described in "Sending Multiple Content Items for Translation" on page 51.
by selecting the SyncTranslation check box in the Automatic Item Export for Translation dialog box, as
described in "Submitting a Content Item for Translation using the Content Editor" on page 39 and
"Submitting Content for Translation from the Page Editor or the Experience Editor" on page 46.
Note: You enable this feature when you create an item and attach it to a workflow. For details, see "Attaching a
New Content Item to a Translation Workflow" on page 20.

2.1.3 Selecting a Translation Provider
If your company has multiple translation providers, your company's Connector setup may enable you to select
which one to use when you send out items for translation.
This feature is available:
in the Translation Queue, as described in "Submitting Content for Translation from the Translation Queue"
on page 73.
in the Translation Options page of the Bulk Translation wizard, as described in "Sending Multiple Content
Items for Translation" on page 51.
when sending an individual content item for translation from the Sitecore Content Editor, as described in
"Submitting a Content Item for Translation using the Content Editor" on page 39.
when sending an individual content item for translation from the Sitecore Page Editor, as described in
"Submitting Content for Translation from the Page Editor or the Experience Editor" on page 46.

2.2 The Connector at a Glance
You access the Clay Tablet Connector for Sitecore ("Connector") directly from the Sitecore user interfaces–from
the Content Editor, the Page Editor, and the Desktop.
Note: Not all Connector features are available in all Sitecore user interfaces.

Sitecore Content Editor
You can use the CTC Translation tab in the Sitecore Content Editor to perform multiple translationmanagement tasks and to view a summary of the translation status of all the content items in your Sitecore
instance:
Sitecore 6 and 7
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2 Getting Started with the Clay Tablet Connector for Sitecore

2.2 The Connector at a Glance

Sitecore 8

You can use the Translate button in the Review tab in the Sitecore Content Editor to send out a single item
for translation:
Sitecore 6 and 7

Sitecore 8

You can use the WorkflowCT3Config template to build your own translation workflow:
Sitecore 6 and 7
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2 Getting Started with the Clay Tablet Connector for Sitecore

2.2 The Connector at a Glance

Sitecore 8

You can use the CT3 Sample Workflow workflow to configure your translation workflow:
Sitecore 6 and 7
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2.2 The Connector at a Glance

Sitecore 8
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2 Getting Started with the Clay Tablet Connector for Sitecore

2.2 The Connector at a Glance

Sitecore Page Editor (Sitecore 6 and 7)
You can use the Translate To button on the CTC Translation tab in the Sitecore Page Editor to send a single
content item for translation:

Sitecore Experience Editor (Sitecore 8)
You can use the Translate To button on the CTC Translation tab in the Sitecore Experience Editor to send a
single content item for translation:

Sitecore Desktop (Sitecore 6 and 7)
You can use the menu items in the CTC Translation folder on the Sitecore menu.
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2 Getting Started with the Clay Tablet Connector for Sitecore

2.3 Working with Lists

2.3 Working with Lists
The Connector has many list pages, often for displaying lists of content items.
Tips: For lists where you can select multiple items, press the Shift key to select a range of adjacent items.
Press the Ctrl key to select multiple non-adjacent items.
You can perform the following actions in list pages:
A list with many items may have multiple pages. You can navigate among pages in a list. For details, see
"Navigating Pages in a List" on page 16.
You can set the width of a column in the list. For details, see "Setting Column Width" on page 17.
You can change the column order. For details, see "Changing Column Order" on page 18.
You can sort the items in the list by a specific column. For details, see "Sorting by Column" on page 17.
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2 Getting Started with the Clay Tablet Connector for Sitecore

2.3 Working with Lists

You can search for an item in the Translation Status window. For details, see "Monitoring Status for Multiple
Items" on page 84.
You can specify the number of items to display in a single page in the Translation Status window. For details,
see "Monitoring Status for Multiple Items" on page 84.
You can group the items in the list by one of the columns in the Translation Status window. For details, see
"Grouping Content Items by Column in the Translation Status Window" on page 87.

2.3.1 Navigating Pages in a List
If there are many items in a list, the list may have multiple pages. The navigation bar below the list helps you
navigate through the pages and displays your position in the list.
For example, the Select an Account dialog box may have multiple pages in its list.

You use the arrow keys at the bottom of a list to navigate through multiple pages in a list.
Arrow Key

What It Does
Opens the first page.
Opens the previous page.
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2 Getting Started with the Clay Tablet Connector for Sitecore

Arrow Key

2.3 Working with Lists

What It Does
Opens the next page.
Opens the last page.

The bottom right corner of the windows displays the current page in the list, the total number of pages in the
list, and the total number of items in the list. The maximum number of items displayed in a list page depends on
the particular list.

2.3.2 Setting Column Width
You can set the width of any column in a list.
1. Mouse-over the right border of the column.
The cursor is displayed as a white line with arrows at each end.

2. Drag the column border to its new position.
Dragging the column border to the left makes the column narrower.
Dragging the column border to the right makes the column wider.

2.3.3 Sorting by Column
By default, items in a list are displayed by alphabetical order of the item in the first column of the list.
You can sort items in a list by any column. For example, suppose that in the Translation Status window, you
want to display all content items by language.
Click the column heading.
For example, click the Language column heading.
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2 Getting Started with the Clay Tablet Connector for Sitecore

2.3 Working with Lists

The first time you click in the column heading, the column contents are sorted in ascending order. The arrow
in the column heading indicates the sort order.

If you want to reverse the sort order, click again in the column heading.

2.3.4 Changing Column Order
You can change the order in which columns in lists are displayed. For example, suppose you want to move the
Language column to the right of the Version column.
1. Click the column heading to move.
For example, click the Language column heading.

2. While you hold down the cursor, drag the column heading to the new position. (A copy of the column
heading "floats" above the table.) Red arrows indicate the new position of the column.

3. Release the cursor when the column is in its new position.
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3 Creating Content for Translation

3.1 Attaching a New Content Item to a Translation Workflow

3 Creating Content for Translation
If you are sending a single content item for translation, it must have a translation workflow assigned.
There are three ways to do this when you create a content item:
Assign it to the sitecore/System/Templates/ClayTablet3/WorkflowCT3Config template.
This template uses the translation workflow, which is contained in the
sitecore/System/Workflows/CT3 Sample Workflow.
Assign it to your own template. Ensure that your template uses the translation workflow, which is
contained in the sitecore/System/Workflows/CT3 Sample Workflow.
Assign it to your own template, which uses your own workflow. Ensure that the base template of your
workflow is /sitecore/templates/System/Workflow/TranslationWorkflow. For detailed
instructions, refer to the Clay Tablet Connector for Sitecore Installation and Configuration Guide,
Special Edition for use with Lionbridge onDemand.
If a content item was already created, but a translation workflow was not assigned to it, you must assign a
translation workflow to that item. For details, see page 25.
If you are sending multiple content items together using the Bulk Translation feature, you do not need to
assign a translation workflow to individual content items. You can assign a translation workflow and assign a
workflow state to all items without an assigned workflow. For details, see "Sending Multiple Content Items
for Translation" on page 51.

3.1 Attaching a New Content Item to a Translation Workflow
To create an item that you can send for translation individually, you must either use a template that has the
Clay Tablet workflow attached, or use a template that is attached to your custom translation workflow.
Note: If you will be sending an item for translation using the Bulk Translation feature, described in "Sending
Multiple Content Items for Translation" on page 51, you do not need to assign a template with a translation
workflow to the item.
1. In the Sitecore Content Editor, under Content in the navigation pane, locate the place in the tree where you
want to create a new item that will be sent for translation. Next, right-click and select Insert > Insert from
Template in the context menu.
The Insert from Template dialog box opens.
2. Select one of the following templates:
The template attached to the default Connector workflow,
Templates/ClayTablet3/WorkflowCT3Config.
The template attached to your custom translation workflow, if you have created one.
3. Click Insert.
The item opens, displaying the Content tab.

Clay Tablet Connector for Sitecore User Guide, Special Edition for use with Lionbridge onDemand
Version 3.9.8

Page 20
May 27, 2016

3 Creating Content for Translation

3.1 Attaching a New Content Item to a Translation Workflow

4. Enter the content to translate in the Data section.
5. In the CT3Translation section, specify the following workflow options:
Parameter

Description

Default Value

Field Types to be Sent
For Translation

Determines which types of fields the Connector can send
out for translation when it sends an item for translation.
This is relevant for all templates. If you create a custom
field type, you must add it to this list so that you can
send it out for translation.
Note: You cannot set Shared Fields to be sent out for
translation, because these fields are shared across all
versions and languages of an item.
To change these fields, click the Edit button above the
list. In the dialog box that opens, select the field types to
add, and use the blue arrow to copy them to the
Selected column. When you are done, click OK.
Tip: You can use the Shift key to select multiple
adjacent field types.

By default, the
Connector sends out
fields of the following
field types for
translation:
text
Rich Text
html
Single-Line Text
Multi-Line Text

Translate From (Source
Language)

The source language from which to translate the items.
Select a language from the list.

Usually this is the
Sitecore default
language.

Translate To (Target
Language)

The target languages that are available for translating the
items attached to the workflow. To translate into specific
target languages, select the corresponding check boxes.

n/a
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3 Creating Content for Translation

3.1 Attaching a New Content Item to a Translation Workflow

Parameter

Description

Default Value

Synchronize Translation
(detect changed content
and resend)

Determines whether the SyncTranslation feature is
available when translating items attached to this
workflow. This feature checks each field of the source
version for any content changes, and it sends only
changed content fields out for translation, to ensure that
all target versions reflect these changes.
When this check box is selected, you can activate this
feature by selecting a check box in either the Bulk
Translation wizard or the Automatic Item Export for
Translation dialog box. The SyncTranslation feature
may reduce translation costs, but it needs the
Connector translation backup data, and it increases
the Connector processing time before the Connector
sends out the items for translation.
When this check box is cleared, you cannot activate
this feature, because the related user interface is not
displayed. The Connector sends all specified source
content for translation, even if it has not changed
since it was previously sent for translation.

check box is cleared

Requested Translation
Timeframe (Days)

Determines the translation deadline when sending out
the translation automatically, without using the user
interface that supports entering this information in the
Delivery Date field. This information is sent to the
translation provider as metadata of the translation
package. If you set this parameter to 14, the deadline will
be two calendar weeks after you submit an item for
translation.
Recommendation: Discuss whether to use this feature
with your translation provider(s).

15

Workflow State to set
when Sending Content
for Translation

The workflow state to set when a source item has been
selected for translation.

/sitecore/system/
Workflows/CT3
Sample Workflow/
Sending for
Translation
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3 Creating Content for Translation

3.1 Attaching a New Content Item to a Translation Workflow

Parameter

Description

Default Value

Workflow State to set
(for Source Content)
once content has been
sent for translation

The workflow state to set for a source item after the
Connector has sent it out for translation. For example, in
some companies, when you send out the content for
translation, the source is ready for publishing. In this
scenario, you can set this state to Done, which is a
publishable state. Alternatively, if your company has a
final review process, you can set this to another state
that is not publishable.

By default, this state
is not set, so the
source item's state
does not change
when you send it out
for translation.

Workflow State to set
for Content while it is
out for translation

The workflow state to set for target content when an
item is being translated. The default In Translation
workflow state enables you to see which items are still
out for translation. It facilitates following up with your
translator about items that you have sent out for
translation, but that you have not yet received back.

/sitecore/system/
Workflows/CT3
Sample Workflow/In
Translation

Workflow State to set
when a translation
process has been
cancelled

The workflow state to set when an item’s translation
request has been cancelled.
A user can cancel translation from the Translation Queue.
A translation request is automatically cancelled if a fatal
error occurs while sending out an item for translation,
such as an incorrect language code, or insufficient user
permissions.

/sitecore/system/
Workflows/CT3
Sample Workflow/
Reviewing

Workflow State to set
when content
Translation is complete

The workflow state to set when an item translation has
been completed, and it is back in Sitecore for review and
publishing.

/sitecore/system/
Workflows/CT3
Sample Workflow/
Editing Translated
Version
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3.1 Attaching a New Content Item to a Translation Workflow

Parameter

Description

Default Value

Send Content
automatically using preconfigured language
settings

Enables sending all items to the Translation Queue
without further user action. That is, the Connector
automatically uses the Translate from, Translate to and
Requested Translation Timeframe information, defined
above, to immediately send content to the Translation
Queue without enabling the user to change these
parameters: the Language Selection pop-up window does
not open.
If this check box is selected, the Language Selection
pop-up window does not open when you send
content to the Translation Queue: you cannot select
the target languages or the destination, but sending
items for translation is streamlined.
If this check box is cleared, the Language Selection
pop-up window opens when you send content out for
translation: you can select the target languages, so the
process is less streamlined. However, this provides
greater control for the user.

check box is cleared

Automatically Publish
content when it reaches
the Final State

Determines whether the Connector automatically
publishes the content when an item reaches the final
state of the translation workflow.
If this check box is selected, the Connector
automatically publishes the content when an item
reaches the final state.
If this check box is cleared, the Connector does not
automatically publish the content when an item
reaches the final state.

check box is selected

Publish to which
Database?

The target databases for publishing content if the
Connector needs to publish an item.

n/a

Publish child items?

Determines whether the Connector publishes child items
when it publishes their parent item.
If this check box is selected, the Connector publishes
child items when it publishes their parent item.
If this check box is cleared, the Connector does not
publish child items when it publishes their parent
item.

check box is selected
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3.2 Attaching a Translation Workflow to an Existing Content Item
If you have a content item that is attached to a template that does not include a translation workflow, you can
still prepare to send it out for translation individually. To do so, you assign a translation workflow to the content
item.
Note: You can assign a translation workflow to a content item only if you can assign a workflow to that content
item. This means that the content item must inherit the workflow data item from its data template. For more
information, refer to the Sitecore Data Definition Reference. This guide is available in the documentation section
of the Sitecore Developer Network (SDN) site, at http://sdn.sitecore.net/Reference.aspx. You must log in to this
site to access the documentation.
To attach a translation workflow to an existing content item:
1. In the Sitecore Content Editor, navigate to the content item to which you want to attach a translation
workflow and select it.
2. In the Sitecore Content Editor ribbon, click the Review tab.
3. In the Workflow section, click Edit.
Tip: If the Workflow section is not visible, then in the Sitecore Content Editor ribbon, click the View tab and
select the Standard Fields check box.
4. In the Content tab, scroll down to the Workflow section.
5. If necessary, click the Expand button

to expand the Workflow section.

6. In the Workflow field, click the arrow to select CT3 Sample Workflow or another translation workflow.
7. Optional. In the State field, click the arrow to select the workflow state.
8. In the Review tab on the Sitecore Content Editor ribbon, in the Workflow section, click Check In.
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3.3 Filtering Fields in Items that Do Not Need Translation
You can use the Translation Filter window to filter out fields that never need translation. You can access this
feature from either the Sitecore Content Editor or the Sitecore Desktop.
You initially specify which types of fields the Connector sends for translation using the Field Types to be Sent
For Translation workflow-level parameter.For details, see "Attaching a New Content Item to a Translation
Workflow" on page 20.
You use the Translation Filter feature to further exclude certain types of fields from content that the Connector
sends for translation, per the template. You can create filters when initially configuring the Connector, or you
can create or update the filters at any time.
When a user sends out an item for translation, the Connector collects the content from all fields in the item with
the field types specified in that parameter, in preparation for sending them out for translation. Then, if there are
some fields that you do not want to send for translation, even though they belong to field types that the
Connector sends out for translation, you can use the Translation Filter to exclude them.
1. Do one of the following to open the Translation Filter window:
In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Translation Filter.
Sitecore 6 and 7

Sitecore 8

In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Translation Filter from the menu.
The Translation Filter window opens.
If you use the Sitecore Content Editor in Sitecore 6 or 7, it opens in a separate browser window.
If you use the Sitecore Content Editor in Sitecore 8 or the Sitecore Desktop, it opens in the same browser
window.
Sitecore 6 and 7
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Sitecore 8

2. Click the Add button

to add a new filter.

The Welcome page of the Field Filter wizard opens.
3. Click Next.
The Choose a Content Template page of the Field Filter wizard opens.
Sitecore 6 and 7
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Sitecore 8
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4. Select the content template to associate with the fields you want to filter, and exclude from translation. Use
the Expand and Collapse icons to navigate the tree. Click Next.
The Select Fields that you don't want sent out for translation page of the Field Filter wizard opens.
Sitecore 6 and 7

Clay Tablet Connector for Sitecore User Guide, Special Edition for use with Lionbridge onDemand
Version 3.9.8

Page 29
May 27, 2016

3 Creating Content for Translation

3.3 Filtering Fields in Items that Do Not Need Translation

Sitecore 8
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This page displays the following information about all the fields in the template you selected:
Column

Description

Field

The name of a field type in the template.

Type

The description of the field type.

Shared

Indicates whether the field type is shared.

Template

The template where the field type is located.

5. Select the check boxes of the field types you want to exclude from translation, and click Next.
Note: Shared fields are never sent for translation, so they are automatically excluded from translation. You
do not need to select them.
The Don't transfer field value page of the Field Filter wizard opens.
Sitecore 6 and 7
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Sitecore 8
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This page displays only the field types you selected in the previous page of the wizard.
6. For each field type, indicate whether you want the Connector to copy the source-language content to the
target version.
If you do not want the Connector to copy the source-language content of a field type to the target
version, select the corresponding check box. This field type will be excluded from the target content.
If you want the Connector to copy the source-language content of a field type to the target version, clear
the corresponding check box. This field type will be included in the target content; however, the content
will be in the source language.
Click Next.
The summary page of the wizard opens.
Sitecore 6 and 7
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This page displays the following information about the fields to exclude in the new filter.
Column

Description

Template

The name of the template where the field type to exclude from translation is located.

Field

The name of the field type to exclude from translation.

Type

The type of field to exclude from translation.

Don't transfer
field value

Indicates whether the Connector copies the source-language content to the target
version for this field type.
Blank indicates that the Connector does copy the source-language content of a field
to the target version, select the corresponding check box. This field will be included in
the target content; however, it will be in the source language.
yes indicates that the Connector does not copy the source-language content of a
field type to the target version. The Connector does not automatically transfer the
value of the field in the source version to the field in the target version.

7. Click Finish.
8. Sitecore 8 only. A message box opens, confirming that you want to close the wizard. Click OK.
The wizard closes, and the CTC Translation Filter window displays each filter you created in a separate row:
Sitecore 6 and 7
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Sitecore 8

This window displays the following information about the filters:
Column

Description

Template
Path

The path and name of the template. Field types in this template can be excluded from
translations.

Field
Name

When the Connector sends out content items based the specified template for translation, it
does not send out this field's content for translation.

Field
Type

The type of this field to exclude from translation. When [ALL] is displayed, then all types of
this field are excluded from translation.
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Column

Description

Don't
transfer
field
value

Indicates whether the Connector copies the source-language content to the target version for
this field type.
false indicates that the Connector does copy the source-language content of a field type
to the target version, select the corresponding check box. This field will be included in the
target content, however it will be in the source language.
true indicates that the Connector does not copy the source-language content of a field to
the target version. The Connector does not automatically transfer the value of the field in
the source version to the field in the target version.

Now that you have created a filter, you can perform the following actions in the CTC Translation Filter
window (in addition to the Add Filter button, which was described above in step 3):
Button

Description
Deletes all filters displayed in the CTC Translation Filter window.

Deletes all selected filters from the CTC Translation Filter window.

Applies the selected filter to all templates with the same field type.

Refreshes the list of displayed filters.

Clay Tablet Connector for Sitecore User Guide, Special Edition for use with Lionbridge onDemand
Version 3.9.8

Page 37
May 27, 2016

4 Sending Content to Translation

4.1 Workflow States

4 Sending Content to Translation
If you send a single content item for translation, it must be in a workflow state that enables it to be sent for
translation. This corresponds to the Reviewing workflow state that is part of the default CT3
SampleWorkflow translation workflow. If you send multiple content items for translation using the Bulk
Translation feature, you can assign a workflow and workflow state to the items at that time.
When the Connector sends out content items for translation, the following events occur:
1. The Connector exports the content from the Sitecore CMS as HTML or XML files. The format is determined
by the ClayTablet.PackedFileFormat setting in the CT3Translation.config file. For details, refer
to the Clay Tablet Connector for Sitecore Installation and Configuration Guide, Special Edition for use with
Lionbridge onDemand.
2. The Connector creates placeholders for the content of the language versions of the specified target
languages.
3. The Connector delivers the export files to the Clay Tablet Platform, along with information about the target
languages, and source location within Sitecore. The Clay Tablet Platform then delivers these files to the
translation provider(s) specified in your company's routing rules.
Note: Using the translation workflow for a content item does not obligate you to send out that content item for
translation. You can move the content item through the entire workflow without sending it out for translation.

4.1 Workflow States
The sitecore/System/Workflows/CT3 SampleWorkflow workflow contains all required states for the
Connector translation management process.
By default, it has the following seven states, which are listed, in order, below.
Workflow State

Relevant for Source Content

Editing

ü

Reviewing

ü

Sending for Translation

ü

Relevant for Target Content

In Translation

ü

Editing Translated Version

ü

Reviewing Translated Version

ü

Done

ü

ü
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Note: Only content in the Done state is publishable.

4.2 Submitting a Content Item for Translation using the Content Editor
This section describes how to submit a content item for translation using the Sitecore Content Editor. It is
relevant only for a single content item that uses a template that has a translation workflow attached, as
described in "Creating Content for Translation" on page 20. For instructions on submitting multiple content
items for translation, see "Sending Multiple Content Items for Translation" on page 51. For instructions on
submitting a single content item for translation using the Sitecore Page Editor, see page 46.
Depending on your company's Connector configuration, when you submit the item for translation, either:
The Connector immediately sends out the item for translation.
The Connector sends the item to the Translation Queue, which is a holding area for items that are ready for
translation.
To submit a content item for translation:
1. In the Sitecore Content Editor, navigate to the content item that is ready to sent for translation and select
it.
2. In the Sitecore Content Editor ribbon, click the Review tab.
3. In the Workflow section, click Submit.
Note: The Submit button is displayed only if the content item's workflow state is Editing.
A dialog box opens.
Sitecore 6 and 7

Sitecore 8
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4. Optional. Add a comment to this action. The Connector does not use this comment, but it is available in
Sitecore.
The content item moves to the next state in the workflow, which is Reviewing.
The Workflow section of the Review tab is updated to display the Publish, Reject, and Translate buttons.
Note: These buttons are displayed only if the content item is in the Reviewing workflow state.
Sitecore 6 and 7

Sitecore 8

Note: Using the translation workflow for a content item does not obligate you to send out that content item
for translation. You can move the content item through the entire workflow without sending it out for
translation.
5. Click Translate.
6. Optional. Depending on your company's Sitecore configuration, an additional comment box may be
displayed. If so, you can enter a comment and click OK.
The next step depends on your company's Connector configuration. Usually, the Automatic Item Export for
Translation dialog box opens.
Sitecore 6 and 7
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Sitecore 8
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The following options may be available, depending on your company's Connector configuration:
Option

Description

To
Language

Select the check boxes for the target languages into which you want to translate the
content. If you want to translate the content into all available target languages, select the
Select All check box.
Tip: When you select a target language, if an error states that the language code is
misconfigured, it means that you do not have read access to that language. You require
read access to a language to send out content for translation to that language.
Note: Depending on your company's Connector configuration, some languages may already
be selected. If so, you can clear any selected languages that you do not want to include.
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Option

Description

Sync
Translation

Determines whether to check each field of the source version for any content changes, and
send only changed content fields out for translation. If a field was previously translated and
it has not changed, then the Connector does not send it for translation again: Instead, it
uses the stored translation.
When this check box is selected, the Connector sends only changed content fields out for
translation. This may reduce translation costs, but it increases the processing time before
the Connector sends out the items for translation.
When this check box is cleared, the Connector sends all specified source content for
translation, even if it has not changed since it was previously sent for translation.
Note: This option may not be available, depending on the setup of the content item to the
attached translation workflow. For details, see the description of the
SynchronizeTranslation feature in "Attaching a Translation Workflow to an Existing Content
Item" on page 25. This option may also not be available based your company's Connector
configuration. For details, refer to the description of the SynchronizeTranslation setting in
the Clay Tablet Connector for Sitecore Installation and Configuration Guide, Special Edition
for use with Lionbridge onDemand.

Select one of the following Send To Options:
Send items
to
translation
queue

The Connector sends the content item to the Translation Queue, where a user must
approve it to send it out for translation.
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Option

Description

Send items
to
translation
provider

The Connector sends the content item to the Clay Tablet Platform, which sends it to the
translation provider specified in the company's routing rules. The Connector displays
additional fields below, where you can specify additional information.
Note: This option may not be available, depending on your company's Connector
configuration, which may require that all content items are sent to the Translation Queue
for further approval.
Recommendation: Select this option if you need to quickly send out content and do not
need to arrange or filter it, for example, by language.
Send To: If your company has multiple translation providers, and if your company's
Connector configuration enables selecting the translation provider (instead of using
automatic routing rules), you can select the provider for this item in the dropdown list.
Job Name: Your name for this translation job.
Delivery Date: The requested translation deadline. This is the date when you expect the
translated content to return. By default, it is two weeks from the current date. To select a
different date, either type the delivery date in the field in MM/DD/YYYY format, or click
the arrow and select a different date in the calendar that opens. This information is sent
to the translation provider as metadata of the translation package.
Note: The default displayed date is based on your company's Connector configuration.
Recommendation: Discuss with your translation provider whether to use the
information in this field.
PO Reference: The purchase order reference number.
Description: A description of the translation job, including any special instructions or
requests.

Copy
source to
target only

The Connector copies the source content to the target content item without sending it out
for translation. This is useful when there is content that you do not want to translate, but
that you want to include in the target version. The Connector displays an additional field
below, where you specify the job name.
Job Name: Your name for this job.

7. Click OK to close the dialog box and send the content item to the next step, as described above.
If you sent the content item to a translation provider, or copied the source content to the target, the Job
Progress box opens, indicating the Connector's progress in sending out the item for translation or
copying over the content. Each target language represents an item. Click Close at any time to close the
Job Progress box. The processing and sending continues in the background.
Sitecore 6 and 7
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Sitecore 8

Important: If the Connector sent the item to the Translation Queue, you must approve it there to send it
out for translation. For detailed instructions, see "Submitting Content for Translation from the
Translation Queue" on page 73.
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Note: The Connector never sends out shared fields for translation, because these fields are shared across all
versions and languages of an item.
For information about the events that occur when the Connector sends out content for translation, see
"Sending Content to Translation" on page 38.
Tip: You can monitor the translation progress from within the Sitecore Content Editor. For detailed instructions,
see "Monitoring Translation Status" on page 82.

4.3 Submitting Content for Translation from the Page Editor or the Experience Editor
This section describes how to submit a content item for translation using the Sitecore Page Editor (Sitecore 6
and 7) or the Sitecore Experience Editor (Sitecore 8). Depending on your company's Connector configuration,
when you submit the item for translation, either:
The Connector immediately sends out the item for translation.
The Connector sends the item to the Translation Queue, which is a holding area for items that are ready for
translation.
For instructions on submitting a content item for translation using the Sitecore Content Editor, see page 73.
1. Do one of the following:
Sitecore 6 and 7: In the Sitecore Page Editor ribbon, click the CTC Translation tab.

Sitecore 8: In the Sitecore Experience Editor ribbon, click the CTC Translation tab.

2. In the Translation section, click the Translate To button.
Note: This button is displayed only if the content item is in the Reviewing workflow state.
3. Optional. Depending on your company's Sitecore configuration, an additional comment box may be
displayed. If so, you can enter a comment and click OK.
The Automatic Item export for translation dialog box opens.
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The following options may be available, depending on your company's Connector configuration:
Option

Description

To
Language

Select the check boxes for the target languages into which you want to translate the
content. If you want to translate the content into all available target languages, select the
Select All check box.
Tip: When you select a target language, if an error states that the language code is
misconfigured, it means that you do not have read access to that language. You require
read access to a language to send out content for translation to that language.
Note: Depending on your company's Connector configuration, some languages may already
be selected. If so, you can clear any selected languages that you do not want to include.
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Option

Description

Sync
Translation

Determines whether to check each field of the source version for any content changes, and
send only changed content fields out for translation. If a field was previously translated and
it has not changed, then the Connector does not send it for translation again: Instead, it
uses the stored translation.
When this check box is selected, the Connector sends only changed content fields out for
translation. This may reduce translation costs, but it increases the processing time before
the Connector sends out the items for translation.
When this check box is cleared, the Connector sends all specified source content for
translation, even if it has not changed since it was previously sent for translation.
Note: This option may not be available, depending on the setup of the content item to the
attached translation workflow. For details, see the description of the
SynchronizeTranslation feature in "Attaching a Translation Workflow to an Existing Content
Item" on page 25. This option may also not be available based your company's Connector
configuration. For details, refer to the description of the SynchronizeTranslation setting in
the Clay Tablet Connector for Sitecore Installation and Configuration Guide, Special Edition
for use with Lionbridge onDemand.

Select one of the following Send To Options:
Send items
to
translation
queue

The Connector sends the content item to the Translation Queue, where a user must
approve it to send it out for translation.
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Option

Description

Send items
to
translation
provider

The Connector sends the content item to the Clay Tablet Platform, which sends it to the
translation provider specified in the company's routing rules. The Connector displays
additional fields below, where you can specify additional information.
Note: This option may not be available, depending on your company's Connector
configuration, which may require that all content items are sent to the Translation Queue
for further approval.
Recommendation: Select this option if you need to quickly send out content and do not
need to arrange or filter it, for example, by language.
Send To: If your company has multiple translation providers, and if your company's
Connector configuration enables selecting the translation provider (instead of using
automatic routing rules), you can select the provider for this item in the dropdown list.
Job Name: Your name for this translation job.
Delivery Date: The requested translation deadline. This is the date when you expect the
translated content to return. By default, it is two weeks from the current date. To select a
different date, either type the delivery date in the field in MM/DD/YYYY format, or click
the arrow and select a different date in the calendar that opens. This information is sent
to the translation provider as metadata of the translation package.
Note: The default displayed date is based on your company's Connector configuration.
Recommendation: Discuss with your translation provider whether to use the
information in this field.
PO Reference: The purchase order reference number.
Description: A description of the translation job, including any special instructions or
requests.

Copy
source to
target only

The Connector copies the source content to the target content item without sending it out
for translation. This is useful when there is content that you do not want to translate, but
that you want to include in the target version. The Connector displays an additional field
below, where you specify the job name.
Job Name: Your name for this job.

4. Click OK to close the dialog box and send the content item to the next step, as described above.
If you sent the content item to a translation provider, or copied the source content to the target, the Job
Progress box opens, indicating the Connector's progress in sending out the item for translation or
copying over the content. Each target language represents an item. Click Close at any time to close the
Job Progress box. The processing and sending continues in the background.
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If you sent the content items to the Translation Queue, a message box opens, indicating that the
Connector sent the content and the source and target languages. Click OK to close the message box.
Important: If the Connector sent the item to the Translation Queue, you must approve it there to send it
out for translation. For detailed instructions, see "Submitting Content for Translation from the
Translation Queue" on page 73.

Note: The Connector never sends out shared fields for translation, because these fields are shared across all
versions and languages of an item.
For information about the events that occur when the Connector sends out content for translation, see
"Sending Content to Translation" on page 38.

4.4 Sending Multiple Content Items for Translation
The Bulk Translation feature enables you to select, send, and receive large quantities of content for translation
in only a few clicks.
This is useful for quickly sending out entire sections, sites, or content trees for translation.
You access the Bulk Translation feature from either the CTC Translation tab on the Sitecore Content Editor
ribbon, or from the Start menu on the Sitecore Desktop.
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Important: When you use the Bulk Translation tool, you can initially select a large set of content items, based
on the content navigation tree, and then in subsequent steps you exclude items from that group that you do
not want to send out for translation.

Bulk translation and workflow
Recall that you do not need to attach a translation workflow to the content items when you use the bulk
translation feature. However, the Assign Translation Workflow to items with no workflow defined? option in
the wizard enables you to attach a workflow to the items you send out, and you can set the workflow state for
those items. This is recommended because it helps manage those items later, especially in the workbox.
Recommendation: Plot out your requirements before starting the Bulk Translation wizard, because this feature
has powerful implications. Consider the following issues:
Does every item already have a workflow attached?
If every item does not already have a workflow attached, do you want to attach the translation workflow to
those items?
If you want to attach the translation workflow to items previously without a workflow, which workflow state
do you want to assign to those items?
What are the repercussions of attaching the workflow and assigning the workflow state to these items?

To send content for translation using the Bulk Translation feature:
1. Do one of the following to open the Bulk Translation wizard:
In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Bulk Translation.
Sitecore 6 and 7

Sitecore 8

In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Bulk Translation from the menu.
The Settings page of the wizard opens.
Sitecore 6 and 7

Clay Tablet Connector for Sitecore User Guide, Special Edition for use with Lionbridge onDemand
Version 3.9.8

Page 52
May 27, 2016

4 Sending Content to Translation

4.4 Sending Multiple Content Items for Translation

Sitecore 8

Clay Tablet Connector for Sitecore User Guide, Special Edition for use with Lionbridge onDemand
Version 3.9.8

Page 53
May 27, 2016

4 Sending Content to Translation

4.4 Sending Multiple Content Items for Translation

2. In the Settings page, you choose the following settings:
Setting

Description

Source Language

The Connector will send items in this source language for translation. By default this
is the default Sitecore language. You can select another language from the list.
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Setting

Description

Translate these
items into the
following Target
Languages

Select the check boxes for all the target languages into which you want to translate
the source content. The list displays all the Sitecore languages that are set up for the
Connector.
Tip: Use the Select All button to select all available languages.
Tip: When you select a target language, if an error states that the language code is
misconfigured, it means that you do not have read access to that language. You
require read access to a language to send out content for translation to that
language.
Note: In a later step of this wizard, you can select individual content items from the
list of content items and modify their target languages. This is useful for any specific
exceptions that may require special target language treatment.

Items to send

This section displays the names of items you can send for translation and the date
and time they were created. By default, these items are sorted in order of reverse
chronological creation date.
To sort these items by name, click Sort by job name.
To sort these items by date, click Sort by creation date.
You can choose one of the following settings:
Select items to send: This displays all items in the specified source language.
Select items sent in past jobs: This displays all items in the specified source
language that were previously sent for translation.
Note: Later in the wizard you can exclude items from this list.

When you are done, click Next.
If in the previous step you selected Select items to send, then the Root of Source Item page of the
wizard opens. Proceed to the next step.
If in the previous step you selected Select items sent in past jobs, then the Translation Options page of
the wizard opens. Proceed to step 8.
3. In the Root of Source Item page, you select the highest-level root folder of all source items to send for
translation. In later steps, you can exclude items so that you do not send them for translation. In addition,
content selected using the Bulk Translation feature is sent by default to the Translation Queue, which
enables you to further sort and select the items to send for translation.
Sitecore 6 and 7
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Use the Expand and Collapse
items to send for translation.
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icons to navigate the tree and include the highest root folder of all source

Optional. To send only the highlighted root item for translation without including its child items, select
the Send selected root item only check box at the top of the page.
Optional. To send items dependent on selected content items out for translation, select the Send
dependent items check box at the top of the page. This is useful, for example, if a page item has multiple
layers with different data sources, and you want to translate all the items displayed in the page.
Notes: Your company can configure which dependent items the Connector sends for translation when
this check box is selected. It can also configure the default value of this check box. For detailed
instructions, refer to the ClayTablet Connector for Sitecore Installation and Configuration Guide.
Tip: If you specify the highest root in your Sitecore project, all content from a site or Content Server, you can
send all your project content for translation at one time.
When you are done, click Next.
The Specify Source Filters page of the wizard opens.
4. In the Specify Source Filters page, you specify the filters to apply to the source content, which limits the
content that you send for translation. It enables you to apply very specific conditions and precisely control
which content you send out for translation. For example, using the filters on this page, you can select all the
items created by a certain user, during a given date range, and then send only the latest version of those
items.
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Important: These filters are inclusive parameters. Only items that match all filter parameters will be available
for further selection on subsequent pages of the wizard.
Sitecore 6 and 7

Sitecore 8
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You can use the following filters:
Filter

Description

Item version
filter

You filter the version or versions of the content items that the Connector sends out for
translation. The following options are available:
Send only the latest version: The Connector sends only the latest version of content
for translation. This is the default selection.
Send the latest published version: The Connector sends only the latest published
version of content for translation. This is suitable when a company publishes content
before sending it for translation.
Send all published versions: The Connector sends all published versions of content
for translation.
Send all versions: The Connector sends all versions of content for translation.
Note: If you select one of the last two options, the Connector sends multiple versions of
the same content items for translation.
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Filter

Description

Creation date
filter

You filter the creation date of the content items that the Connector sends out for
translation. In the From and To fields, either enter the range of content-creation dates in
MM/DD/YYYY format, or click the arrow and select a date from the calendar that opens.

Modification
date filter

You filter the modification date of the content items that the Connector sends out for
translation. In the From and To fields, either enter the range of content-modification
dates in MM/DD/YYYY format, or click the arrow and select a date from the calendar that
opens.

Publish date
filter – Publish
Date

You filter the publication date of the content items that the Connector sends out for
translation. In the Publish Date field, either enter the content-publication date in
MM/DD/YYYY format, or click the arrow and select a date from the calendar that opens.

Publish date
filter – Take
workflow into
account

This setting determines whether the Connector checks the Publish date filter.
If this check box is selected (default value), then the Connector includes in the filter
only items that both match the publish date and those that need publishing to be
approved through the workflow.
If this check box is cleared, then the Connector includes in the filter items that match
the publish date whether or not publishing must be approved through the workflow.

Created by
filter

You create a filter based on who created the content item. This can be either users, or
roles assigned to users, or both.
To add a filter to this list, click Add. For detailed instructions, see page 71.
To remove a filter from this list, select it and click Remove.

Updated by
filter

You create a filter based on who updated the content item in Sitecore. This can be either
users, or roles assigned to users, or both.
To add a filter to this list, click Add. For detailed instructions, see page 71.
To remove a filter from this list, select it and click Remove.

Tip: To clear the information from any filter, click the corresponding Clear Filter button.
When you are done, click Next.
The Excluding Item(s) page of the wizard opens.
5. In the Excluding Item(s) page of the wizard, you can precisely control the translation parameters for each
content item you sent for translation. This helps you manage any exceptional translation requirements. You
can:
Remove content items from the list, so that you do not send them out for translation.
Note: If you selected the Send dependent items check box at the bottom of the Root of Source Item
page, in step 4, above, then if you exclude some items from the list, their dependent items will
automaticallybe excluded.
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Change the target language of each item to send out for translation. For example, you may select a
section of your web site to be bulk exported for translation into German, but you want to translate the
top-level page items of that section into Spanish and French too.
Change the version of each item to send out for translation for each target language. For example, you
may want an older version of the source content translated into a specific target language.
Sitecore 6 and 7

Sitecore 8
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To remove one or content items from the list, so that you do not send the out for translation, select the
corresponding check boxes in the left page, and click
Remove X checked items out of Y at the bottom
of the list, where X is the number of items that are already selected for removal, and Y is the total number
of items displayed in the list.
Tips: Use the Shift key to select a range of adjacent roles or users. Use the Ctrl key to select multiple
non-adjacent roles or users.
Tips: To select all content items in the list, click
content items in the list, click
Un-Check All.

Check All. To clear the check boxes for all selected

Tips about working with branches: To select all the content items in a branch, select one item in that
branch and then click
Check a branch. To clear the check boxes for all selected content items in a
branch, click
Un-Check a branch.
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To change the target languages and versions to translate, click a content item in the left pane to highlight
it, as shown in the above screen capture. The right pane now displays the target languages set up for the
Connector. Any target languages that you selected earlier, in the Settings page of the wizard, are selected.
You can change this default selection by selecting the check boxes for additional target languages or
clearing the check boxes for selected target languages.
To change the version assigned to the content item, change the version number in the Version box for
the language. If you select Default, the version number is incremented by one.
To save your changes to a target language and version for a content item, click
the right pane.

Update at the bottom of

6. When you are done, click Next.
The Translation Options page of the wizard opens.
Sitecore 6 and 7
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Sitecore 8

7. In the Translation Options page of the wizard, you can assign a workflow to items without a workflow, set
the workflow state for the content items you are sending to translation, send only changed content fields for
translation, and decide whether to immediately send the content item out for translation, send it to the
Translation Queue first, or copy the source content to the target version without translating it. You can set
the following options:
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Option

Description

Assign Translation
Workflow to items with no
workflow defined?

You can attach a translation workflow to the content items you send out for
translation, and you can set the workflow state for those items. This is
recommended because it helps manage those items later, especially in the
workbox.
Tip: If you initially send out your entire site for translation before setting up
workflow, do not set the bulk items to an initial workflow state.
Note: Depending on your company's configuration, you may not be able to
send out content items for translation unless they are attached to a
translation workflow. You can change this configuration with the
ClayTablet.PreventSentingItemsWithoutWorkflow setting in the
CT3Translation.config file. For details, refer to the Clay Tablet
Connector for Sitecore Installation and Configuration Guide, Special Edition
for use with Lionbridge onDemand.
Note: By default, the translation workflow is the CT3 Sample Workflow.
You can set the default workflow state using the
ClayTablet.StateToAssignInBulkTranslation setting in the
CT3Translation.config file. For details, refer to the Clay Tablet
Connector for Sitecore Installation and Configuration Guide, Special Edition
for use with Lionbridge onDemand.
To assign the translation workflow to any content items without a
workflow assigned, select this check box.
To proceed with the translation process without assigning a translation
workflow to content items without a workflow, clear this check box.
With state: If you select this check box, you select the workflow state to
apply to all source content items that previously did not have a translation
workflow assigned. For a list and description of workflow states, see page
38.
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Option

Description

Sync Translation: Only
send fields with changed
content. Unchanged fields
will have the original
translation automatically
copied to the target
version.

Determines whether to check each field of the source version for any
content changes, and send only changed content fields out for translation.
If a field was previously translated and it has not changed, then the
Connector does not send it for translation again: Instead, it uses the stored
translation.
When this check box is selected, the Connector sends only changed
content fields out for translation. This may reduce translation costs, but
it increases the processing time before the Connector sends out the
items for translation.
When this check box is cleared, the Connector sends all specified source
content for translation, even if it has not changed since it was previously
sent for translation.
Note: This option may not be available, depending on the setup of the
content item to the attached translation workflow. For details, see the
description of the SynchronizeTranslation feature in "Attaching a
Translation Workflow to an Existing Content Item" on page 25. This option
may also not be available based your company's Connector configuration.
For details, refer to the description of the SynchronizeTranslation setting in
the Clay Tablet Connector for Sitecore Installation and Configuration
Guide, Special Edition for use with Lionbridge onDemand.
Note: This option may not be available, based your company's Connector
configuration. For details, refer to the Clay Tablet Connector for Sitecore
Installation and Configuration Guide, Special Edition for use with
Lionbridge onDemand.

Select one of the following Send To Options:
Send items to translation
queue

The Connector sends the content items to the Translation Queue, where a
user must approve them to send them out for translation.
Recommendation: Select this option if you want to use the Translation
Queue to batch together many items for translation into many target
languages, but then only immediately send out those items for translation
into a single language.
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Option

Description

Send items to translation
provider

The Connector sends the content items to the Clay Tablet Platform, which
sends it to the translation provider specified in the company's routing rules.
Connector displays additional fields below, where you can specify additional
information.
Note: This option may not be available, depending on your company's
Connector configuration, which may require that all content items are sent
to the Translation Queue for further approval.
Recommendation: Select this option if you need to quickly send out
content and do not need to arrange or filter it, for example, by language.
Send To: If your company has multiple translation providers, and if your
company's Connector configuration enables selecting the translation
provider (instead of using automatic routing rules), you can select the
provider for this item in the dropdown list.
Job Name: Your name for this translation job.
Delivery Date: The requested translation deadline. This is the date when
you expect the translated content to return. By default, it is two weeks
from the current date. To select a different date, either type the delivery
date in the field in MM/DD/YYYY format, or click the arrow and select a
different date in the calendar that opens. This information is sent to the
translation provider as metadata of the translation package.
Note: The default displayed date is based on your company's Connector
configuration.
Recommendation: Discuss with your translation provider whether to use
the information in this field.
PO Reference: The purchase order reference number.
Description: A description of the translation job, including any special
instructions or requests.

Copy source to target only

The Connector copies the source content to the target content item
without sending it out for translation. This is useful when there is content
that you do not want to translate, but that you want to include in the target
version. The Connector displays an additional field below, where you specify
the job name.
Job Name: Your name for this job.

When you are done, click Next.
The Summary Report page of the wizard opens.
8. Use the Summary Report page to review the content items you are sending for translation as well as the
target languages, if applicable.
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Click Submit to send the content items to the next step, which you specified earlier in the Translation
Options page of the wizard.
The final page of the wizard opens, displaying the following information:
The number of content items sent out for translation, to the Translation Queue, or copied over to the
target version without translation.
Whether the items were sent out for translation, to the Translation Queue, or copied over to the target
version without translation.
Important: If the Connector sent the items to the Translation Queue, you must approve them there to
send them out for translation. For detailed instructions, see "Submitting Content for Translation from the
Translation Queue" on page 73.
A list of all content items, including their paths, that the Connector sent out for translation, to the
Translation Queue or copied over to the target version without translation.
Sitecore 6 and 7
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If you sent the content items to a translation provider, or copied the source content to the target, the Job
Progress box is displayed at the bottom of the page, indicating the Connector's progress in sending out the
items for translation or copying over the content. The Number of Items refers to the number of content
items in the source language. In the other columns, each target language represents an item.
9. Click Finish to close the wizard. The processing and sending continues in the background.

4.4.1 Adding a Source Filter when Sending Multiple Items for Translation
The Select an Account dialog box (Sitecore 6 and 7) or the Add an Account dialog box (Sitecore 8) opens when
you click the Add button in the Created by filter section or the Updated by filter section in the Specify Source
Filters page of the Bulk Translation wizard.
You use this dialog box to create a filter for sending bulk content for translation based on roles or individual
users who created or updated the content items.
Sitecore 6 and 7

Clay Tablet Connector for Sitecore User Guide, Special Edition for use with Lionbridge onDemand
Version 3.9.8

Page 71
May 27, 2016

4 Sending Content to Translation

4.4 Sending Multiple Content Items for Translation

Sitecore 8

Clay Tablet Connector for Sitecore User Guide, Special Edition for use with Lionbridge onDemand
Version 3.9.8

Page 72
May 27, 2016

4 Sending Content to Translation

4.5 Submitting Content for Translation from the Translation Queue

By default, this window displays all roles. By default, the items in the list are displayed in alphabetical order.
To display users instead of roles, click Users in the Account Type box at the topic of the window.
Roles are displayed in alphabetical order.
If users are displayed, they are displayed in alphabetical order.
You select the roles for the filter. For example, if you are creating a filter to include only content created by users
assigned to certain roles, you select these roles.
Tips: Use the Shift key to select a range of adjacent roles or users. Use the Ctrl key to select multiple nonadjacent roles or users.
For information about navigating the pages in the list, see "Navigating Pages in a List" on page 16.
When you are done, click OK.

4.5 Submitting Content for Translation from the Translation Queue
You submit content for translation from the Translation Queue in the following scenarios:
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When you reviewed content, you submitted it to the Translation Queue, by selecting the Send items to
translation queue radio button, instead of immediately sending it for translation, as described in the
previous sections:
"Submitting a Content Item for Translation using the Content Editor" on page 39
"Submitting Content for Translation from the Page Editor or the Experience Editor" on page 46
"Sending Multiple Content Items for Translation" on page 51
Your company is configured to always submit content items to the Translation Queue before sending them
out for translation.
Submitting content to the Translation Queue before sending it out for translation has the following advantages:
You may not want to send out each content item individually as soon as you finish reviewing it. The
Translation Queue facilitates your management of reviewed content, so that you do not forget about
sending individual reviewed content items for translation.
Your translation provider may prefer receiving fewer but larger batches of content to translate, rather than
individual content items, as it facilitates project preparation, resource assignment, and file analysis.
If you want to translate many items into multiple languages, but you want to translate into only one target
language at a time, this is a good way to manage that process.
If you or your colleagues have added content items to the Translation Queue, you must access it and approve
the files you want to send out.
Note: If you do not approve content items in the Translation Queue, the Connector does not send them out for
translation.
When you send content for translation from the Translation Queue, you can add project metadata, including a
project name and a requested delivery date, when the translations will be returned.
Note: These instructions assume you already have content items in the Translation Queue. For information on
submitting content to the Translation Queue, see "Submitting a Content Item for Translation using the Content
Editor" on page 39.
To submit one or more content items from the Translation Queue for translation:
1. Do one of the following to open the Translation Queue:
In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Translation Queue.
Sitecore 6 and 7

Sitecore 8
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In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Translation Queue from the menu.
The Translation Queue opens.
Sitecore 6 and 7

Sitecore 8
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The top of the window displays the total number of estimated words in all the content items in the queue.
The window displays all the content items in the queue that you submitted.
Note: If you are assigned to the sitecore\Translation Administrator role, the Show queue items
from all users check box is displayed. To view all items in the queue, select this check box.
The window displays the following information about the content items in the queue:
Column

Description

Item
Path

The path and name of the content item.

Database

The database that stores this content item.

Language

The language code of the source language of the content item to send for translation.

Version

The version of the content item to send for translation.

Translate
To

The language codes of the target languages into which to translate the content item.
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Column

Description

Sync

Indicates whether the Optimize Translation feature is enabled for this content item. This
feature sends only changed content fields out for translation, which reduces translation costs.
If this column has a value of Yes, then this feature is enabled for this content item.
If this column is blank, then this feature is not enabled for this content item.

Deadline

The requested date for received the translated content back from the translation provider, in
MM/DD/YYYY format.

Created

The date when the source content item was created, in MM/DD/YYYY format.

Words

The number of words in the content item.

User

The user who submitted this content item to the queue. Displayed only if you are assigned to
the sitecore\Translation Administrator role, and if you selected the Show queue
items from all users check box, described above.

Note: To change the number of items displayed on a page in the queue, select a number from the Page size
dropdown list. By default, 20 items are displayed on a page.
2. Do one of the following:
Select one or more content items to send for translation, and click Send Selected.
Tips: Use the Shift key to select a range of adjacent items. Use the Ctrl key to select multiple nonadjacent items.
Click Send All.
The Send Items Out for Translation dialog box opens.
Sitecore 6 and 7
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The items you selected to send are in the items to send pane on the left. If you did not select all the items in
the queue, then the items you did not select are in the items in queue pane on the right.
3. Choose one of the following:
To send the selected items to your translation provider, select Sending X items for translation to, where
X is the number of selected items. If your company has multiple translation providers, and if your
company's Connector configuration enables selecting the translation provider (instead of using automatic
routing rules), you can select the provider for this project in the Send item(s) to dropdown list.
Enter the following information about the project in the fields at the top:
Option

Description

Job Name

Your name for this translation job.
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Option

Description

Delivery
Date

The requested translation deadline. This is the date when you expect the translated
content to return. By default, it is two weeks from the current date. To select a different
date, either type the delivery date in the field in MM/DD/YYYY format, or click the arrow
and select a different date in the calendar that opens.
This information is sent to the translation provider as metadata of the translation
package.
Note: The default displayed date is based on your company's Connector configuration.
Recommendation: Discuss with your translation provider whether to use the
information in this field.

PO
Reference

The purchase order reference number.

Description

A description of the translation job, including any special instructions or requests.

This information is delivered to your translation provider along with the content items for translation.
To copy over the selected items to the target version, without translating them, select Copy X items from
source to target language, where X is the number of selected items.
4. Optional. To add other items to your project, select them in the more items in queue pane on the right and
click Add.
Note: To remove items from your project, select them in the items to send pane on the left and click
Remove.
5. To send the items for translation or copy the source to the target, without translation, click OK.
The Job Progress box opens, indicating the Connector's progress in sending out the items for translation or
copying over the content. Each target language represents an item.
Sitecore 6 and 7
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6. Click Close at any time to close the Job Progress box. The processing and sending continues in the
background.
Tip: To monitor the translation progress, In the Translation Tools section of the CTC Translation tab, click
Translation Status. For detailed instructions, see "Monitoring Translation Status" on page 82.
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5 Monitoring Translation Status
You can track the status of your translation projects from within the Content Editor, from the CTC Translation
tab on the ribbon. There are three ways to monitor the translation status:
View the status summary, as described on page 83.
View the status of a single item, as described on page 89.
View the status for all in your project, as described on page 84.
For a list and description of translation statuses, see "Translation Statuses" on page 82.

5.1 Translation Statuses
Content items have one of the following translation statuses:
Translation
Status

Description

Percentage
Translation
Complete

[In Queue]
Wait for
approval

The Connector sent the item to the Translation Queue. It must be
approved in the queue before the Connector sends it out for translation.

0%

Preparing

The Connector is preparing to send out the item to the translation
provider.

1%

Sending

The Connector is preparing to send out the item to the translation
provider.

1%

Sent to CTT

The Connector is preparing to send out the item to the translation
provider.

2%

Sent to LSP

The Connector completed sending out the item to the translation provider.

5%

In
Translation

The translation provider has received the item for translation and has not
yet returned the translated item.

10%

Received

The Connector received the translated item back from the translation
provider.

90%

Completed

The Connector has returned the translated item to Sitecore.

100%

No field to
translate

There are no fields to translate in the content item. (The fields may have
been excluded by the Translation Filter or the filter in the Bulk Translation
wizard.)

100%
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5.2 Viewing Your Translation Status Summary
You can view a summary of the translation status of all content items in this Sitecore instance.
To view this summary, on the Sitecore Content Editor ribbon, click the CTC Translation tab. The summary is
displayed on the Translation Statuses section of CTC Translation tab.
Sitecore 6 and 7

Sitecore 8

The following information is displayed about your content items:
Information

Description

Percentage
Translation
Complete

In Queue

The number of content items in the Translation Queue.

0%

Preparing

The number of content items that the Connector is preparing
to sent to the Clay Tablet Platform.

1%

Sending

The number of content items that the Connector is currently
sending to the Clay Tablet Platform.

n/a

Sent to CTT

The number of content items that the Connector sent to the
Clay Tablet Platform, which is currently preparing to send them
out for translation.

2%

Sent to LSP

The number of content items that the translation vendor has
received to translate.

5%

In Translation

The number of content items that the translation vendor has
received to translate.

10%

Received

The number of translated content items that the Connector
has received back from the translation provider.

90%
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Percentage
Translation
Complete

Information

Description

Completed

The number of translated content items that the Connector
has returned to Sitecore.

100%

Jobs (Archived)

The number of translation jobs that the Connector has sent
out for translation. A job includes one or more content items.
The number of archived jobs is in brackets.

n/a

Backup Translations

The number of content items for which the translations are
backed up.

n/a

Archived

The number of archived content items.

n/a

CTT Log Files

The number of CTT log files that are in the $(dataFolder)
/Logs/ folder.

n/a

5.3 Monitoring Status for Multiple Items
You can view the translation status of multiple content items from either the Sitecore Content Editor or the
Sitecore Desktop.
Do one of the following to open the Translation Status window:
In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Translation Status.
Sitecore 6 and 7

Sitecore 8

In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Translation Status from the menu.
The Translation Status window opens, displaying the translation status of all content items that you submitted.
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By default, the content items are sorted by path. For information on changing the sort order and other features
when working with lists, see page 15.
Sitecore 6 and 7

Sitecore 8

If you are assigned to the sitecore\Translation Administrator role, the following check boxes are
displayed:
Show jobs from all users: Select this check box to view all submitted content items.
Show archived jobs: Select this check box to view archived jobs.
This window displays the following information about each content item:
Column

Description

Item
Path

The path and name of the content item.

Language

The target Connector language code for the content item.
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Column

Description

Version

The incremental version number of the source content item.

Type

This is one of the following:
New Translation: new translation requested.
Fix Translation: translation correction requested.
Sync Translation: request to synchronize translation with other target languages.
Copy to Target: source content copied to target without translation.

Provider
Ref

The Lionbridge Freeway project ID.

Status

For a list and description of translation statuses, see page 82.

Percent

The percentage of the content item that has been translated, which is based on the translation
status. For details, see page 82.

ETA

The date that the translation provider expects the translation of the content item to be
complete, in MM/DD/YYYY format.

Updated

The date the content item was updated, in MM/DD/YYYY format.

Actions
You can perform the following actions in the Translation Status window:
To change the number of items displayed on a page in the window, select a number from the Page size
dropdown list. By default, 20 items are displayed on a page.
To display only content items for a particular translation job, select the job from the Job dropdown list and
click Refresh.
To display only content items with a particular translation status, select the status from the Status dropdown
list and click Refresh.
To update a remote TM (translation memory) server with the latest changes from multiple items in a single
translation job, select the job from the Job dropdown list, then select multiple items, and click Update
Remote TM. For detailed instructions, see "Updating a Remote TM Server for Multiple Items" on page 125.
To archive a completed job so that it will no longer be displayed in this window, select it from the Job
dropdown list, and click Archive Job. A message box opens, confirming that you want to archive the specified
job. Click OK to proceed. Available only if you are assigned to the sitecore\Translation
Administrator role.
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Recommendation: Archive only completed jobs. If you archive a job that is in progress (for example, with In
Translation status), then the Connector will no longer process the content items in that job.
To un-archive an archived job so that it that it is active again, select it from the Job dropdown list, and click
Unarchive Job. A message box opens, confirming that you want to un-archive the specified job. Click OK to
proceed. Available only if you are assigned to the sitecore\Translation Administrator role.
To specify the number of items displayed on a page, select it from the Page size list. You can select from 20
(default), 50, 100, and 200. Use the scroll bar to scroll down to the items at the bottom of the page.
To view one or more content items, select them, and click Open Selected Items. Each content item opens in
the Content tab in a separate browser window.
If the translation has Completed status, the Content tab displays the translated version.
If the translation has Sent to CTT status (for a correction request), the Content tab displays the
translated version.
Otherwise, the Content tab displays the source version.
To refresh the list of content items in the window based on a new selection in the Job or Status filters, or
newly created content items, click Refresh.
To navigate to another page in the list, click a button in the navigation bar below the list. For detailed
instructions, see page 16.
To group content items by a column, click the column heading. While you hold down the cursor, drag the
column heading to the Drag a column to this area to group by it area above the list on the left. For details,
see page 87.
To search for one or more content items in the list, enter the search criteria in the Search box in the top right
corner of the list, and press Enter. The Connector searches all columns and displays only items that match
the search criteria.

5.3.1 Grouping Content Items by Column in the Translation Status Window
In the Translation Status window, you can group the items in the Translation Status window by one of the
columns. For example, suppose that you want to group the content items by the Status column.
1. Click the column heading. For example, click the Status column heading.
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2. While you hold down the cursor, drag the column heading to the Drag a column to this area to group by it
area above the list on the left.
This list items are grouped by the column you dragged.

3. Click an Expand button

to view the items in each column group.
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For a detailed description of the Translation Status window, see "Monitoring Status for Multiple Items" on
page 84.

5.4 Monitoring Status for a Single Item
You can view the translation status of a single content item, or of a group of content items under a common
root folder.
1. Navigate to the content item whose translation status you want to check.
2. In the Sitecore Content Editor ribbon, click the CTC Translation tab.
3. In the Translation Tools section, click Item Translation Details.
Sitecore 6 and 7

Sitecore 8

The Translation Status tab for the content item opens.
Sitecore 6 and 7
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Sitecore 8

This tab displays the following translation-status information about the selected content item and any child
items:
Note: The Translation tab is blank if either the content item has not been sent for translation, or it was sent
to the Translation Queue, and then it was removed from the queue.
Column

Description

Item

This is the item path and name. The preceding icon indicates the translation status, as
described below:
One of the following statuses: Completed; No field to translate.
All other statuses.
For a list and description of translation statuses, see page 82.
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Column

Description

Source

The ISO code of the source language and the version number of the source content. For
example, if this content item is in English, and it is the first version, this is en [V:1].

Target

The regional ISO code of the target language and the version number of the target
content. For example, if this content item is in Japanese, and it is the first version, this is
ja-JP [V:1].
Note: If there are multiple translation targets, then multiple regional ISO codes and
version numbers are displayed.

Created

The date and time when the content item was created, in the following
format: MM/DD/YYYY HH:MM:SS.

Translated

A percentage indicating how much of the content item has been translated. This is based
on the translation status, which is described in "Translation Statuses" on page 82.

Translation
Status

For a list and description of translation statuses, see page 82.

Last Update

The date and time when the content item was last updated, in the following
format: MM/DD/YYYY HH:MM:SS.

TNS Type

Translation type. This is one of the following:
New Translation: new translation requested.
Fix Translation: translation correction requested.
Sync Translation: request to synchronize translation with other target languages.
Copy to Target: source content copied to target without translation.
Queued Translation: content is in Translation Queue.

TNS Backup

Indicates whether the translation of the content item is backed up in the database. It has
one of the following values:
Yes
No
Note: This is determined by the ClayTablet.BackupTranslationData setting in the
CT3Translation.config file. For details, refer to the Clay Tablet Connector for
Sitecore Installation and Configuration Guide, Special Edition for use with Lionbridge
onDemand.
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Column

Description

Reference

The regional ISO language code and version of an item.
For an item that has not been sent out for translation yet, for example, an item in the
Translation Queue, it refers to the source language and version of the item that will be
translated.
For an item that has already been sent out for translation, it refers to the target
language and version.

Actions
When you are viewing the translation status, you can also perform the following actions:
To refresh the translation status information for the content items in the list, click the Refresh button
the top of the tab.

at

To remove a content item from the Translation Queue, so that the Connector will not send it for translation,
select it, right-click, and select Remove from the Translation Queue from the context menu. Available only
for items that have not been translated yet and are in the Translation Queue, with [In Queue] Wait for
approval or Sent to CTT status.
To approve a content item for translation in the Translation Queue, so that the Connector will send it for
translation, select it, right-click, and select Approve this queue item for translation from the context menu.
Available only for items that have not been translated yet and are in the Translation Queue, with [In
Queue] Wait for approval or Sent to CTT status.
To update a remote TM (translation memory) with source content that was edited after it was sent for
translation, select it, right-click, and select Send post-edited content to Update a remote TM from the
context menu. Available only for items that have already been translated, with Completed status. For
details, see "Updating a Remote TM Server" on page 120.
To request a correction of translated content, select the corresponding source content item, right-click, and
select Request Translation Correction from the context menu. Available only for items that have already
been translated, with Completed status. For details, see "Requesting Translation Corrections" on page 115.
To update additional target languages to match the updated translated content, select the corresponding
source content item, right-click, and select Synchronize Translated Versions from the context menu.
Available only for items that have already been translated, with Completed status. For detailed instructions,
see "Synchronizing Translation of Other Target Languages" on page 110.
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6 Monitoring Items in a Workflow with the Enhanced Workbox
Clay Tablet's optional enhanced Workbox has more features than the standard Sitecore Workbox. These
features help you manage large lists of content items in a workflow. You can sort by different column headings,
approve many items at once, and easily manage the display of long lists.
Important: The enhanced Workbox is an optional feature that replaces the standard Sitecore Workbox. It must
be installed as a separate package. For installation instructions, refer to the Clay Tablet Connector for Sitecore
Installation and Configuration Guide, Special Edition for use with Lionbridge onDemand.
You open the enhanced Workbox the same way that you open the standard Sitecore Workbox.

To open the enhanced Workbox:
In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > Workbox from the
menu.
In the Sitecore Content Editor, either:
Click the Workbox link in the bottom left corner of the Content Editor.
Click the dropdown arrow in the top right corner of the Content Editor and select the Workbox link.
When you open the Workbox, it displays all content items in a workflow, grouped first by workflow (if multiple
workflows are selected), and then by workflow state.
Sitecore 6 and 7

Sitecore 8
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In the enhanced Workbox, you can perform actions on all content items in a workflow, on all content items in a
workflow state, or on individual content items.
For information about displaying content items in the Workbox, see page 94.
For information about viewing and receiving updates for all content items in a workflow, see page 96.
For information about viewing and receiving updates for all content items in a workflow state, see page 96.
For information on viewing detailed information about content items, see page 98.
For information on changing the workflow state of a single content item, see page 100.
For information on changing the workflow state of multiple content items, see page 102.
For information about comparing multiple version of a content item, see page 104.
For information on viewing the history of workflow-state changes to a content item, see page 103.

6.1 Displaying Content Items in the Workbox
The Workbox ribbon includes many features for controlling which content items to display in the Workbox and
how to display these items.

Ribbon
Section
Workflows

Description of Functionality
Select the check box for one or more workflows. The Workbox displays the content items
assigned to these workflows. The top-level grouping of content items is by workflow.
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Ribbon
Section

6.2 Viewing Workflow Details and Receiving Updates

Description of Functionality

Filter

In the Language dropdown list, select the language of the content items to view, or to view
content items in all languages, accept the default, -- ALL --. Depending on the workflow
state of the content item, this may be the source or target language:
Editing, Reviewing, Sending for Translation, and In Translation workflow
states: source language of the content item.
Editing Translated Version, Reviewing Translated Version, and Done
workflow states: target language of the content item.

Sort

In the Field dropdown list, select the field for sorting the content items in the Workbox. By
default, the content items are displayed in descending order by the specified field. To sort the
content items in ascending order, clear the Descending check box.
Note: All content items are grouped first by workflow and then by workflow state before they
are sorted.

View

In the Items per Page dropdown list, select the number of content items to display within a
page in a workflow-state section, or select All.
Note: You can click page numbers in the bottom-right corner of each page to navigate.

To refresh the Workbox based on your changes, click Refresh

.

6.2 Viewing Workflow Details and Receiving Updates
You can view the number of content items in a workflow and subscribe to updates about these items.
If the workflow section is not already expanded, click

(Sitecore 6 and 7) or

(Sitecore 8) to expand it.

Sitecore 6 and 7
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Updates

Sitecore 8

You can now see the all the workflow states in the workflow, and the number of content items assigned to
each workflow state.
You can perform the following actions:
To subscribe to an RSS feed of a workflow, so that you will be modified of any workflow-state changes to
content items assigned to this workflow, click
in the top-right corner of the workflow section.
To collapse an expanded workflow section, click

.

To close a workflow section, click the Close (X) box in the top-right corner.
Note: This clears the selected check box for the workflow, in the Workflows section of the ribbon.

6.3 Viewing All Content Items in a Workflow State and Receiving Updates
You can view the content items in a workflow state and receive updates about them.
1. If the workflow section is not already expanded, click

to expand it.

2. Click
(Sitecore 6 and 7), click
or click the title, which is the name of the workflow state, to expand the
corresponding workflow-state section.
Sitecore 6 and 7
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Sitecore 8

You can now see all the content items in that workflow state.
In the screen captures, the content items assigned to the CT3 Sample Workflow workflow are displayed
in the Workbox. The section for the Editing workflow state is expanded, while the sections for the other
workflow states are collapsed.
Note: If the number of items in a workflow state exceeds the number specified in the Items per Page setting,
click a number in the bottom-right corner of the section to navigate to a different page, where you can see
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additional content items. To change the Items per Page setting, select another number, or All, from the
dropdown list in the View section of the Workbox ribbon.
You can perform the following actions in a workflow-state section:
To subscribe to an RSS feed of a workflow state, so that you will be notified of any workflow-state changes
to content items in this state, click
.
To collapse an expanded workflow-state section, click

, or click the title of the section.

To view details about the content items in this state, see page 98.
To change the workflow state of a single content item, see page 100.
To change the workflow state of multiple content items, see page 102.
To view the history of workflow-state changes to a single content item, see page 103.
To compare multiple versions of a single content item, see page 104.

6.4 Viewing Content Item Details
You can view detailed information about a content item in a specific workflow and workflow state.
1. Ensure that the section for the workflow to which the content item is assigned is displayed in the Workbox. If
it is not displayed, select the corresponding check box in the Workflows section of the Workbox ribbon. For
details, see page 94.
2. Ensure that the section for the workflow to which the content item is assigned is expanded. If it is not
expanded, click to expand it.
3. Ensure that the section for the workflow-state section to which the content item is assigned is expanded. If it
is not expanded, click , or click the title of the section, which is the name of the workflow state, to expand
it.
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When a workflow-state is expanded, you can see detailed information about a content item. The screen
capture shows the section for the Editing Translated Version workflow state collapsed, while the
section for the Reviewing Translated Version workflow state is expanded. The information in
brackets below indicates the information in the highlighted area in the screen capture above.
The name of the content item (D3X).
The language of the content item (German, Germany). Depending on the workflow state of the content
item, this may be either the source or the target language:
Editing, Reviewing, Sending for Translation, and In Translation workflow states:
source language of the content item.
Editing Translated Version, Reviewing Translated Version, and Done workflow states:
target language of the content item.
The version number of the content item in the specified language (version 4).
The last change in the workflow state of the item, the user who made this change, the previous and
current workflow states, and the date of this change (admin changed from Editing Translated
Version to Reviewing Translated Version on Wednesday, May 18, 2011.).
You can also perform the following actions on any content item:
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To open a content item in the Sitecore Content Editor, click the name of that item or click Open
To view a preview of a content item in the layout for the current device, click Preview

.

.

6.5 Changing the Workflow State of Individual Content Items
You can change the workflow states of one or more content items in a workflow. The changes you can make
depend on the workflow state of the items.
1. Ensure that the section for the workflow to which the content item is assigned is displayed in the Workbox. If
it is not displayed, select the corresponding check box in the Workflows section of the Workbox ribbon. For
details, see page 94.
2. Ensure that the section for the workflow to which the content item is assigned is expanded. If it is not
expanded, click to expand it.
3. Ensure that the section for the workflow-state section to which the content item is assigned is expanded. If it
is not expanded, click , or click the title of the section, which is the name of the workflow state, to expand
it.

The screen capture shows the section for the Editing workflow state expanded. In this state, the Submit
action is available.
4. You can perform one of the following state-specific actions. The available actions depend on the content
item's workflow state. Refer to the table below for a list and description of actions you can perform on
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content items in different states of the CT3 Sample Workflow workflow.
Available in these Workflow States
Action

Description
Editing

Reviewing

In
Translation

ü

Editing
Translated
Version

Reviewing
Translated
Version

ü

Submit

Submits a content itemto
the next workflow state.

Publish

Publishes the content
item:
Reviewing: publishes
in the source language.
Reviewing
Translated
Version: publishes in
the target language.

ü

ü

Reject

Rejects the content item,
so that it is not
publishable:
Reviewing: rejects
content in the source
language.
Reviewing
Translated
Version: rejects
content in the target
language.

ü

ü

Translate

Opens a dialog box for
specifying translation
settings before sending
this content item for
translation.

ü

Language
Translated

Moves a content item to
the next workflow state,
Editing Translated
Version.

ü
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6.6 Changing the Workflow State of Multiple Content Items
You can perform any workflow-state-specific actions on multiple content items that are in the same workflow
state. For example, you can publish or reject multiple content items in the Reviewing Translated
Version workflow state. Different actions are available, depending on the workflow state, as described in
"Changing the Workflow State of Individual Content Items" on page 100.
To change the workflow state of multiple content items:
1. Ensure that the section for the workflow to which the content item is assigned is displayed in the Workbox. If
it is not displayed, select the corresponding check box in the Workflows section of the Workbox ribbon. For
details, see page 94.
2. Ensure that the section for the workflow to which the content item is assigned is expanded. If it is not
expanded, click to expand it.
3. Ensure that the section for the workflow-state section to which the content item is assigned is expanded. If it
is not expanded, click , or click the title of the section, which is the name of the workflow state, to expand
it.
4. Optional. Select the check boxes for the content items for which you want to perform the common action.
Note: If you want to perform the action on all the content items in the workflow-state section, skip this step.
5. If necessary, scroll down to the bottom of the page of the workflow-state section, so that the toolbar at the
bottom of the section is displayed.
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The screen capture shows the Reviewing Translated Version workflow state expanded. In this state,
the Publish and Reject actions are available.
Note: The available actions depend on the workflow state. Refer to the table in "Changing the Workflow
State of Individual Content Items" on page 100 for a list and description of actions you can perform on
content items in different states of the CT3 Sample Workflow workflow.
6. Click the icon in the toolbar for the action you want to perform.
Tip: Click the Toggle checkboxes icon to toggle your check box selection.

6.7 Viewing the History of Workflow-State Changes to a Content Item
You can view the history of workflow-state changes to a content item.
1. Ensure that the section for the workflow to which the content item is assigned is displayed in the Workbox. If
it is not displayed, select the corresponding check box in the Workflows section of the Workbox ribbon. For
details, see page 94.
2. Ensure that the section for the workflow to which the content item is assigned is expanded. If it is not
expanded, click to expand it.
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3. Ensure that the section for the workflow-state section to which the content item is assigned is expanded. If it
is not expanded, click , or click the title of the section, which is the name of the workflow state, to expand
it.
4. In the workflow-state section, locate the content item whose history you want to view.
5. To view the history of workflow-state changes to a content item, click More.

A window opens, displaying information about each change in the workflow state of this content item. The
information in brackets below indicates the information in the screen capture below:
The user name of the user who changed the workflow state of this item (dlangdon).
The date of the change to the workflow state of this item (Monday, June 30, 2014).
The previous and new workflow state. When an item is created, Item created is displayed.

6. When you are done viewing the history of the item, click the Close box (X) in the top-right corner to close the
window.

6.8 Comparing Multiple Versions of a Content Item
You can compare multiple versions of a content item.
1. Ensure that the section for the workflow to which the content item is assigned is displayed in the Workbox. If
it is not displayed, select the corresponding check box in the Workflows section of the Workbox ribbon. For
details, see page 94.
2. Ensure that the section for the workflow to which the content item is assigned is expanded. If it is not
expanded, click to expand it.
3. Ensure that the section for the workflow-state section to which the content item is assigned is expanded. If it
is not expanded, click , or click the title of the section, which is the name of the workflow state, to expand
it.
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6.8 Comparing Multiple Versions of a Content Item

4. In the workflow-state section, locate the content item whose versions you want to compare.
5. Under the content item, click Diff

.

Note: This is not meaningful for version 1 of a content item.

The Compare Versions box opens, displaying the newer version in the left column, and the older version in
the right column. The differences are displayed in blue bold.

To view different versions of this content item, select the version numbers from the dropdown lists at the
top of the box.
To collapse a section, click the collapse button

.
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6.8 Comparing Multiple Versions of a Content Item

To view the differences between versions of this content item in a single column, click One Column in the
top-left corner of the box.

The new text is displayed in green bold.
The old text is displayed in red bold with strikethrough.
When you are done, click OK to close the Compare Versions box.
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7 Reviewing Translated Content
After your translation providers translate your content, the Connector automatically delivers it back into
Sitecore. Each translation is available in the correct language version for each item. When the translated content
returns from translation, its workflow state is Reviewing Translated Version.

To view translated content in Sitecore 6 and 7:
1. Navigate to the content item whose translation you want to view.
2. In the Sitecore Content Editor ribbon, click the Review tab.
3. In the top-right corner of the Content tab, click the flag icon representing the default source language.
The Language list opens, displaying all the available target languages. Under each language is the number of
available versions for each language.

4. Select the desired target language from the list to view the translation. By default, the latest version of the
translation is displayed.
5. Optional. To view a different version of the translation, click the version icon, to the right of the flag icon, and
select the desired version to view.

The translation of the content item is displayed.
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6. Scroll down to review the translated content.
7. In the Workflow section of the Review tab, either approve or reject the translation:

To approve the translation, click the Publish button. Its workflow state immediately changes to Done.
The translated content may be immediately available for publishing, depending on your workflow
configuration and whether the Done state is configured as publishable.
To reject the translation, click the Reject button. The workflow state changes to Reviewing, and the
translation status remains Completed.

To view translated content in Sitecore 8:
1. Navigate to the content item whose translation you want to view.
2. In the Sitecore Content Editor ribbon, click the Review tab.
3. In the top-right corner of the Content tab, click the default-source-language button.
The Language list opens, displaying all the available target languages. Under each language is the number of
available versions for each language.

4. Select the desired target language from the list to view the translation. By default, the latest version of the
translation is displayed.
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5. Optional. To view a different version of the translation, click the version button, to the right of the defaultsource-language button, and select the desired version to view.

The translation of the content item is displayed.
6. Scroll down to review the translated content.
7. In the Workflow section of the Review tab, either approve or reject the translation:

To approve the translation, click the Publish button. Its workflow state immediately changes to Done.
The translated content may be immediately available for publishing, depending on your workflow
configuration and whether the Done state is configured as publishable.
To reject the translation, click the Reject button. The workflow state changes to Reviewing, and the
translation status remains Completed.
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8 Post-Translation Features
After the translation is complete, approved, and published, you can perform the following additional optional
tasks:
Task

Description

Details

synchronize
translation

If a content item has been translated into multiple target languages, and you
updated only one target language, you can use this feature to update additional
target languages.

page
110

request a
translation
correction

If you find a mistake in the translated content, you can send a request to the
translation provider to correct the translation and resend it.

page
115

update a
remote TM
server

You can update a remote TM (translation memory) server, used by your
translation provider, with your latest changes to the translated content.

page
120

clear the
translation
backup data

You can clear the translation backup database. This database supports the
following features: Translation Correction, Update Remote TM, and
SyncTranslation.

page
130

8.1 Synchronizing Translation of Other Target Languages
After a content item is translated, you can update translated versions in other target languages with changes in
the source language. This synchronizes translations of a content item in multiple target languages. This is useful
if you changed the content in the source language, and updated the translation in one target language.
However, now, you want to update the content in the other target languages. You can specify at the field level
which field types and target languages you want to update for the new content.

To synchronize the translations of a content item:
1. Navigate to the content item whose translations you want to synchronize and select it. Select an item that
meets the following criteria:
It has already been translated, so it has Completed status.
Its translation is backed up in the database, so the value in the TNS Backup column is Yes.
2. On the Sitecore Content Editor ribbon, click the CTC Translation tab.
3. In the Translation Tools section, click Item Translation Details.
Sitecore 6 and 7
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Sitecore 8

The Translation Status tab for the content item opens.
Sitecore 6 and 7

Sitecore 8
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8.1 Synchronizing Translation of Other Target Languages

This tab displays translation-status information about the selected content item and any child items. For a
detailed description of this tab, see "Monitoring Status for a Single Item" on page 89.
4. Select an item that has already been translated. This item has Completed status.
5. Right-click, and select Synchronize Translated Versions from the context menu.
The main page of the wizard opens.
Sitecore 6 and 7

Sitecore 8
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6. The first section displays a list of all field types in the content item that were updated, and that should be
synchronized in the translated items.
Select the check boxes for the field types for which you want to synchronize the translation.
If there are field types for which you do not want to synchronize the translation, leave the check boxes
cleared. The translations for fields of those field types will not be updated.
7. The second section displays the target languages that require translation synchronization.
Keep the check boxes selected for the target languages you want to synchronize.
If there are target languages you do not want to synchronize, clear the check boxes cleared. The
translations for these languages will not be updated.
8. Click Send.
The Connector sends the changes in the selected field types for translation in the specified languages.
Note: The Connector does not create a new version for the synchronized translations.
The summary page of the wizard opens.
Sitecore 6 and 7
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8.1 Synchronizing Translation of Other Target Languages

Sitecore 8
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8.2 Requesting Translation Corrections

It displays the fields that the Connector sends for translation, and the target languages that will be
synchronized.
9. Click Finish.
The wizard closes.

8.2 Requesting Translation Corrections
If you find a mistake in the translated content, you can send a request to your translation provider to correct
the translation and resend it.
Note: If you have multiple translation providers, the Connector sends the correction request to the translator
who originally translated the content.
1. In the Sitecore Content Editor, navigate to the content item for which you want to request a translation
correction.
2. In the Sitecore Content Editor ribbon, click the CTC Translation tab.
3. In the Translation Tools section, click Item Translation Details.
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8.2 Requesting Translation Corrections

Sitecore 6 and 7

Sitecore 8

The Translation Status tab for the content item opens.
Sitecore 6 and 7

Sitecore 8
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8.2 Requesting Translation Corrections

This tab displays translation-status information about the selected content item and any child items. For a
detailed description of this tab, see "Monitoring Status for a Single Item" on page 89.
4. Select an item that meets the following criteria:
It has already been translated, so it has Completed status.
Its translation is backed up in the database, so the value in the TNS Backup column is Yes.
5. Right-click, and select Request Translation Correction from the context menu.
The main page of the wizard opens.
Sitecore 6 and 7

Sitecore 8
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8.2 Requesting Translation Corrections

6. The first section displays a list of all field types in the content item. Select the check boxes for the field types
for which you want to request a correction.
7. In the second section, Notes, enter your correction request for the translation provider.
8. Click Send.
The Connector sends the selected field types in the content item and your notes to the translation provider
as a correction request.
The summary page of the wizard opens.
Sitecore 6 and 7
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8.2 Requesting Translation Corrections

Sitecore 8
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8.3 Updating a Remote TM Server

It displays the translation language pair and the field types for which you requested a translation correction.
9. Click Finish.
The wizard closes.

8.3 Updating a Remote TM Server
After you receive translated content back from your translation provider, if you update that content, you can
send these changes to your translation provider's TM (translation memory) server, referred to as a remote TM.
Your changes will be copied to the UpdateTM folder that resides on your translation provider's FTP server.
Note: This feature is available only with the Clay Tablet FTP Connector. The location of the remote TM server is
specified by the TNS_UpdateTMFolder setting in the FTP configuration file, which is configured by CTT.
You can update a remote TM server in the following ways:
for multiple updated items from a single translation job, as described in "Updating a Remote TM Server for
Multiple Items" on page 125
for a single updated item, as described in "Updating a Remote TM Server for a Single Item" on page 121
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8.3 Updating a Remote TM Server

Note: When you send updated content from a single item to update a remote TM, you can specify which
field types to send.

8.3.1 Updating a Remote TM Server for a Single Item
You can update a remote TM server for a single item, as described below. For instructions on updating a remote
TM server for multiple items from a single translation job, see page 125. For general information about updating
a remote TM server, see page 120.
1. In the Sitecore Content Editor, navigate to the content item for which you want to send updated translation
content to a remote TM.
2. In the Sitecore Content Editor ribbon, click the CTC Translation tab.
3. In the Translation Tools section, click Item Translation Details.
Sitecore 6 and 7

Sitecore 8

The Translation Status tab for the content item opens.
Sitecore 6 and 7
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8.3 Updating a Remote TM Server

Sitecore 8

This tab displays translation-status information about the selected content item and any child items. For a
detailed description of this tab, see "Monitoring Status for a Single Item" on page 89.
4. Select an item that meets the following criteria:
It has already been translated, so it has Completed status.
Its translation is backed up in the database, so the value in the TNS Backup column is Yes.
5. Right-click, and select Send Post-Edited Content to Update a Remote TM from the context menu.
The Update a Remote Translation Memory Server page of the wizard opens.
Sitecore 6 and 7
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Sitecore 8
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8.3 Updating a Remote TM Server

6. The source and target languages are displayed. The main section displays a list of all field types in the
content item. Select the check boxes for the field types that you want to send to the remote TM server.
7. Click Send.
The Connector sends the content from the selected field types to the remote TM server.
The summary page of the wizard opens.
Sitecore 6 and 7

Sitecore 8
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8.3 Updating a Remote TM Server

It displays the translation language pair and the field types for which the Connector sends content to the
remote TM server.
8. Click Finish.
The wizard closes.

8.3.2 Updating a Remote TM Server for Multiple Items
You can update a remote TM server for multiple items from a single translation job, as described below. For
instructions on updating a remote TM server for a single item, see page 121. For general information about
updating a remote TM server, see page 120.
1. Do one of the following to open the Translation Status window:
In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Translation Status.
Sitecore 6 and 7

Sitecore 8
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In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Translation Status from the menu.
The Translation Status window opens, displaying the translation status of all content items that you
submitted.
Sitecore 6 and 7

Sitecore 8
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For detailed information about the Translation Status window, see "Monitoring Status for Multiple Items"
on page 84.
2. Select the job from with the items to send to the remote TM server from the Job dropdown list.
3. Select the items to send to the remote TM server.
Tips: Use the Shift key to select a range of adjacent items. Use the Ctrl key to select multiple nonadjacent items.
4. Click Update Remote TM.
The Settings page of the wizard opens.
Sitecore 6 and 7
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8.3 Updating a Remote TM Server

Sitecore 8

5. The source and target languages are displayed. Select the check boxes for the target languages that you
want to send to the remote TM server, and click Next.
The Preparing page of the wizard opens.
Sitecore 6 and 7
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Sitecore 8

This page displays the number of items to send to the remote TM for updating.
Notes: If there are items in the job that have not been translated yet, a message displays this. If there are no
items that have been modified after translation, a message states: There is no item with post-edit
changes that require TM update.
6. Click Submit.
The Connector sends the content from the selected items to the remote TM server.
The summary page of the wizard opens.
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It displays the number of pages and the translation job name that the Connector sent to the remote TM
server.
7. Click Finish.
The wizard closes.

8.4 Clearing Backup Data
You can delete all the backup data used by the following Connector translation features: Translation Correction,
Update Remote TM, and SyncTranslation. You can delete the backup data from either the Sitecore Content
Editor or the Sitecore Desktop.
1. Do one of the following to open the Translation Data Cleanup wizard:
In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Clear Backup Data.
Sitecore 6 and 7

Sitecore 8
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In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Clear Backup Data from the menu.
The Delete CTC Translation Backup Data page of the wizard opens.
Sitecore 6 and 7

Sitecore 8
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2. Select the types of backup data to delete:
Backup item translations: Individual content item translations at the field level.
Translation logs: Log files of all the events that occurred in a translation project.
Archived jobs: Data in archived jobs.
3. Click Clear.
A warning message box opens.
Sitecore 6 and 7

Sitecore 8
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4. If you are sure you want to delete the backup data, click OK.
The summary page of the wizard opens, displaying the number of each type of backup file you deleted.
Sitecore 6 and 7

Sitecore 8
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5. Click Finish to close the wizard.
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